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1. Course Objective

uCertify's course Learn Wireshark is a complete Wireshark tutorial that covers the following concepts
thoroughly and provides a hands-on experience of Wireshark: Traffic Analysis, Exploring the
Wireshark Interface, Outlining the OSI Model, and so on. This course is for network administrators,
security analysts, students, teachers, and anyone interested in learning about packet analysis using
Wireshark.

2. Pre-Assessment

Pre-Assessment lets you identify the areas for improvement before you start your prep. It determines
what students know about a topic before it is taught and identifies areas for improvement with
question assessment before beginning the course.

3. Exercises

There is no limit to the number of times learners can attempt these. Exercises come with detailed
remediation, which ensures that learners are confident on the topic before proceeding.

159
EXERCISES

4. Quizzes
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Quizzes test your knowledge on the topics of the exam when you go through the course material.
There is no limit to the number of times you can attempt it.

80
QUIZZES

5. flashcards

Flashcards are effective memory-aiding tools that help you learn complex topics easily. The flashcard
will help you in memorizing definitions, terminologies, key concepts, and more. There is no limit to
the number of times learners can attempt these. Flashcards help master the key concepts.

110
FLASHCARDS

6. Glossary of terms

uCertify provides detailed explanations of concepts relevant to the course through Glossary. It
contains a list of frequently used terminologies along with its detailed explanation. Glossary defines
the key terms.

110
GLOSSARY OF

TERMS
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7. Expert Instructor-Led Training

uCertify uses the content from the finest publishers and only the IT industry's finest instructors. They
have a minimum of 15 years real-world experience and are subject matter experts in their fields.
Unlike a live class, you can study at your own pace. This creates a personal learning experience and
gives you all the benefit of hands-on training with the flexibility of doing it around your schedule
24/7.

8. ADA Compliant & JAWS Compatible Platform

uCertify course and labs are ADA (Americans with Disability Act) compliant. It is now more
accessible to students with features such as:

Change the font, size, and color of the content of the course

Text-to-speech, reads the text into spoken words

Interactive videos, how-tos videos come with transcripts and voice-over

Interactive transcripts, each word is clickable. Students can clip a specific part of the video by
clicking on a word or a portion of the text.

JAWS (Job Access with Speech) is a computer screen reader program for Microsoft Windows that
reads the screen either with a text-to-speech output or by a Refreshable Braille display. Student can
easily navigate uCertify course using JAWS shortcut keys.

9. State of the Art Educator Tools

uCertify knows the importance of instructors and provide tools to help them do their job effectively.
Instructors are able to clone and customize course. Do ability grouping. Create sections. Design grade
scale and grade formula. Create and schedule assessments. Educators can also move a student from
self-paced to mentor-guided to instructor-led mode in three clicks.

10. Award Winning Learning Platform (LMS)

uCertify has developed an award winning, highly interactive yet simple to use platform. The SIIA
CODiE Awards is the only peer-reviewed program to showcase business and education technology's
finest products and services. Since 1986, thousands of products, services and solutions have been
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recognized for achieving excellence. uCertify has won CODiE awards consecutively for last 7 years:

2014

1. Best Postsecondary Learning Solution

2015

1. Best Education Solution

2. Best Virtual Learning Solution

3. Best Student Assessment Solution

4. Best Postsecondary Learning Solution

5. Best Career and Workforce Readiness Solution

6. Best Instructional Solution in Other Curriculum Areas

7. Best Corporate Learning/Workforce Development Solution

2016

1. Best Virtual Learning Solution

2. Best Education Cloud-based Solution

3. Best College and Career Readiness Solution

4. Best Corporate / Workforce Learning Solution

5. Best Postsecondary Learning Content Solution

6. Best Postsecondary LMS or Learning Platform

7. Best Learning Relationship Management Solution

2017

1. Best Overall Education Solution

2. Best Student Assessment Solution

3. Best Corporate/Workforce Learning Solution

4. Best Higher Education LMS or Learning Platform

2018

1. Best Higher Education LMS or Learning Platform
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2. Best Instructional Solution in Other Curriculum Areas

3. Best Learning Relationship Management Solution

2019

1. Best Virtual Learning Solution

2. Best Content Authoring Development or Curation Solution

3. Best Higher Education Learning Management Solution (LMS)

2020

1. Best College and Career Readiness Solution

2. Best Cross-Curricular Solution

3. Best Virtual Learning Solution

11. Chapter & Lessons

uCertify brings these textbooks to life. It is full of interactive activities that keeps the learner engaged.
uCertify brings all available learning resources for a topic in one place so that the learner can
efficiently learn without going to multiple places. Challenge questions are also embedded in the
chapters so learners can attempt those while they are learning about that particular topic. This helps
them grasp the concepts better because they can go over it again right away which improves learning.

Learners can do Flashcards, Exercises, Quizzes and Labs related to each chapter. At the end of every
lesson, uCertify courses guide the learners on the path they should follow.

Syllabus

  Chapter 1: Preface

  

Who this course is for?

     

What does this course cover?

     

To get the most out of this course
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  Chapter 2: Appreciating Traffic Analysis

  

Reviewing packet analysis

     

Recognizing who benefits from using packet analysis

     

Identifying where to use packet analysis

     

Outlining when to use packet analysis

     

Getting to know Wireshark

     

Summary

  

  Chapter 3: Using Wireshark NG

  

Discovering the beginnings of today's Wireshark

     

Examining the Wireshark interface

     

Understanding the phases of packet analysis

     

Using command-line tools

     

Summary

  

  Chapter 4: Installing Wireshark on a PC or macOS

  

Discovering support for different OS

     

Comparing different capture engines

www.uCertify.com



     

Performing a standard Windows installation

     

Reviewing the resources available at Wireshark.org

     

Summary

  

  Chapter 5: Exploring the Wireshark Interface

  

Understanding the Wireshark welcome screen

     

Exploring the File menu

     

Discovering the Edit menu

     

Exploring the View menu

     

Summary

  

  Chapter 6: Tapping into the Data Stream

  

Reviewing the network architecture

     

Learning various capture methods

     

Tapping into the stream

     

Realizing the importance of baselining

     

Summary

  

  Chapter 7: Personalizing the Interface
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Personalizing the layout and general appearance

     

Creating a tailored configuration profile

     

Adjusting columns, font, and colors

     

Adding comments

     

Modifying complex expressions

     

Summary

  

  Chapter 8: Using Display and Capture Filters

  

Filtering network traffic

     

Comprehending display filters

     

Creating capture filters

     

Understanding the expression builder

     

Discovering shortcuts and handy filters

     

Summary

  

  Chapter 9: Outlining the OSI Model

  

Comprehending the OSI model

     

Discovering the purpose, protocols, and PDUs
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Exploring the encapsulation process

     

Demonstrating frame formation in Wireshark

     

Summary

  

  Chapter 10: Decoding TCP and UDP

  

Reviewing the purpose of the transport layer

     

Describing TCP

     

Examining the eleven-field TCP header

     

Understanding UDP

     

Discovering the four-field UDP header

     

Summary

  

  Chapter 11: Managing TCP Connections

  

Dissecting the three-way handshake

     

Learning TCP options

     

Understanding TCP protocol preferences

     

Tearing down a connection

     

Summary
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  Chapter 12: Analyzing IPv4 and IPv6

  

Understanding the purpose of the IP

     

Outlining IPv4

     

Exploring IPv6

     

Editing protocol preferences

     

Discovering tunneling protocols

     

Summary

  

  Chapter 13: Discovering ICMP

  

Understanding the purpose of ICMP

     

Dissecting ICMPv4 and ICMPv6

     

Sending ICMP messages

     

Evaluating type and code values

     

Configuring firewall rules

     

Summary

  

  Chapter 14: Understanding ARP

  

Understanding the role and purpose of ARP
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Exploring ARP headers and fields

     

Examining different types of ARP

     

Analyzing ARP attacks

     

Summary

  

  Chapter 15: Troubleshooting Latency Issues

  

Analyzing latency issues

     

Understanding the coloring rules

     

Exploring the Intelligent Scrollbar

     

Discovering the expert system

     

Summary

  

  Chapter 16: Subsetting, Saving, and Exporting Captures

  

Discovering ways to subset traffic

     

Understanding options to save a file

     

Recognizing ways to export components

     

Identifying why and how to add comments

     

Summary
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  Chapter 17: Using CloudShark for Packet Analysis

  

Diving into an overview of CS

     

Sharing captures in CS

     

Outlining the various filters and graphs

     

Evaluating the different analysis tools

     

Discovering where to find sample captures

     

Summary

  

Videos and How To

uCertify course includes videos to help understand concepts. It also includes How Tos that help
learners in accomplishing certain tasks.

20
VIDEOS

01:57
HOURS

12. Practice Test

Here's what you get
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50
PRE-ASSESSMENTS QUESTIONS

50
POST-ASSESSMENTS QUESTIONS

Features

Each question comes with detailed remediation explaining not only why an answer option is correct
but also why it is incorrect.

Unlimited Practice

Each test can be taken unlimited number of times until the learner feels they are prepared. Learner can
review the test and read detailed remediation. Detailed test history is also available.

Each test set comes with learn, test and review modes. In learn mode, learners will attempt a question
and will get immediate feedback and complete remediation as they move on to the next question. In
test mode, learners can take a timed test simulating the actual exam conditions. In review mode,
learners can read through one item at a time without attempting it.

13.  Live Labs

The benefits of live-labs are:

Exam based practical tasks

Real equipment, absolutely no simulations

Access to the latest industry technologies

Available anytime, anywhere on any device

Break and Reset functionality

No hardware costs
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Lab Tasks

Using Wireshark NG

Splitting a File and Work with Filtered File Sets

Using Tshark to Extract HTTP GET Requests

Using Tshark to Capture File Sets with an Autostop Condition

Exploring the Wireshark Interface

Capturing and Classifying Background Traffic

Opening a Network Monitor .cap File

Tapping into the Data Stream

Capturing File Sets

Using a Ring Buffer to Conserve Drive Space

Personalizing the Interface

Adding a Column to Display Coloring Rules in Use

Adding the HTTP Host Field as a Column

Using Display and Capture Filters

Using a Default Filter as a Seed for a New Filter

Creating, Saving, and Applying a DNS Capture Filter

Applying Filters to Locate a Set of Keywords in a Trace File

Exporting a Single TCP Conversation

Applying Filter on HTTP 404 Responses

Filtering Traffic to or from Online Backup Subnets

Filtering HTTP Traffic the Right Way
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Decoding TCP and UDP

Locating TCP Connection Attempts to a Client

Managing TCP Connections

Using Packets to Build a Picture of a Network

Understanding ARP

Investigating an arp Cache

Troubleshooting Latency Issues

Building a Coloring Rule to Highlight FTP User Names, Passwords, and More

Subsetting, Saving, and Exporting Captures

Exporting Malicious Redirection Packet Comments

Reading Analysis Notes in a Malicious Redirection Trace File

Here's what you get

22
LIVE LABS

22
VIDEO TUTORIALS

32
MINUTES

14. Post-Assessment

After completion of the uCertify course Post-Assessments are given to students and often used in
conjunction with a Pre-Assessment to measure their achievement and the effectiveness of the exam.
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